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Safety Notice 

❖ This device is not designed for working on potentially dangerous voltages. 

❖ This device is not designed for working on high energy circuits. 

❖ The maximum DC input voltage is +/- 5V into the device inputs. 

❖ The maximum AC input voltage is +/- 50V into the device inputs. 

❖ See additional safety notices throughout this document. 

Limited Warranty 
This product has a limited warranty for 6 months from the time of purchase. During this time, a device 

failure that occurs under normal operating conditions will be replaced or repaired for free, not including 

shipping. Generally, you will be responsible for shipping to us, and we will be responsible for shipping it 

back to you.  

Devices that have suffered a failure due to operation in excess of specified parameters can usually be 

repaired for a nominal fee. 

The contents of this document are provided “as-is” and may be changed or updated without notice. The 

specifications on a particular product may also be changed at any time and without notice as we seek to 

improve a product or improve availability of a product. 

The limit of our warranty will not exceed the value of the product purchased under any conditions. 
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Legal 
This document and the associated computer codes, hardware design and hardware configuration files 

are copyright © 2011 - 2019 by QuantAsylum USA LLC. All rights are reserved. You may share the 

associated documents in PDF format freely. The EXE programs and code in the developer section is for 

use only with QA products. The hardware and software designs are protected and the property of 

QuantAsylum USA LLC. 

In the Box 
Your new analyzer should contain the following:  

• QA401 Audio Analyzer 

• Certain product variants may contain cables. But as a general rule, we’re moving towards NOT 

shipping common cables with products any longer.  

Installation software, this manual, and application notes for the analyzer are available on the web at 

http://www.QuantAsylum.com. Inside the box you will find a card with a QR code that will take you to 

our web page with the latest information on the product.  

Important Things to Know 

Ground Reference 

The analyzer PC interface will share a ground with the PC. The audio inputs and outputs, however, are 

isolated from the PC. This isolation is limited to 50V. Do not connect the QA401 to a product that has its 

ground reference more than +/-50V from the PC ground.  

BNC Input Voltages 

The AC input to the analyzer should never exceed 56Vpp (single ended) or 28Vpp (differential). The DC 

limits are lower. DC voltages above +/- 6V with the attenuator disengaged may permanently degrade 

the performance of the device.  In general, we recommend a DC limit of +/-5V regardless of attenuator 

setting. If you need to measure power supply noise, see the section in the manual on how to safely do 

so. 

BNC Output Voltages 
The BNC output connectors have a 47 ohm limiting resistor and thus have minimal protection. If you 

accidentally connect a signal of more than  few volts to the outputs, you may damage the output stage. 

QA401 Output Voltage Offsets, Clicks and Pops 
The QA401 output voltages will nominally have an offset of 1-2 mV. If you wish, you can trim those 

offsets to microvolt levels through the Settings->Options->Other->Trim menu. However, be aware that 

certain operations on the QA401 can generate clicks and pops and also modify offsets. This is especially 

true when using external programs to control the QA401.  

http://www.quantasylum.com/
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Also, when changing the sample rate on the QA401, the codecs will be reset to ensure proper 

application of their changed register settings. That will also generate a click or pop on the outputs. 

Normally, these clicks and pops won’t present issues. But if you are working on very high-gain stages 

with speakers or headphones attached, first take the time to familiarize yourself how the various mode 

changes may impact your equipment under test. 

QA401 Analyzer Features 
The QA401 is our second-generation audio analyzer. Our goal in building the QA400 and the QA401 was 

to leverage modern ADC and DAC codecs commonly used for audio analysis, while at the same time 

eliminating some of the bigger problems that come with re-purposing audio ADCs for audio 

measurement.  

The QA401 Features: 

• Stereo differential LEFT + RIGHT inputs 

• Stereo differential LEFT + RIGHT outputs 

• 24-bit ADC and DAC 

• Fully isolated from the PC 

• Input attenuator and hardware-based overload protection 

• USB powered 

We hope you enjoy your purchase! Check back from time to time for new software updates, and drop by 

the forum to say "hello" or ask a question! 

Analyzer Front Panel 
This section covers the various connectors on the analyzer and reviews the input and/or output 

characteristics of these connectors.  

Front Panel Summary 
The front panel is shown in the picture below. From left to right, the following entities are explained. 
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LEDs 
Link LED  This LED indicates the analyzer is connected to the PC and talking to the analyzer 

application.  

Run LED  This LED indicates the analyzer is currently running (acquiring) data. 

Atten LED  This LED indicates the internal 20 dB attenuator is active. The attenuator is active when 

the device is unpowered. However, try not to leave the QA401 connected to large 

voltage swings while the device is unpowered. At higher voltages, it could damage the 

unit.  

BNC Inputs 
There are two stereo inputs (Left and Right) and two stereo outputs (Left and Right). Each input and 

output is differential. This means the magnitude of the + and – are signals are equal and opposite. For 

example, if you were to look at the output signals on an oscilloscope, you’d see that when the L+ output 

was sweeping a sine wave with a peak of +3V, the L- output would be sweeping a mirror image sine 

wage with a peak at -3V. Differential signals are commonly used in noisy environments because 

interfering signals that appear on both inputs simultaneously are “cancelled” and greatly attenuated. 

However, for much of your audio work, you may prefer to use the device in single ended mode 

especially if you are working on line level consumer audio type equipment.  

If you wish to use the inputs single ended, then you could use a BNC terminator on the L- input, and 

treat the L+ input as a single ended input. If you do not use the input terminator, then you will see some 

thermal noise from the unused input resistor, which will raise the overall noise floor.  

Understanding Differential Measurements 
Differential measurements can create confusion even among very experienced engineers. Some 

examples will help highlight the differences.  

If you set the generator to 0 dBV and connect an Output+ to an Input+ and ground the Input-, then the 

measured input will be reported as 0 dBV. 

With the output set to 0 dBV, each output will measure 1Vrms on a DVM relative to ground (BNC outer 

conductor). A differential measurement on a DVM (from Out+ to Out-) will measure as 2Vrms.  This is 

because the Out+ and Out- are 180 degrees out of phase with each other.  

If you set the output to 0 dBV and connect both the Out+ and Out- connectors to the In+ and In- 

connectors, then the QA401 measurement will show a peak of 6 dBV. This is because you are driving the 

inputs differentially. This can be very confusing to first-time users: You are driving the inputs with 1Vrms 

(0 dBV), and yet the QA401 is reporting 2Vrms (6 dBV). But this is precisely the same measurement 

reported by the DVM when you placed the DVM across the outputs.  

Keep in mind the QA401 inputs have no idea if you are driving a single input with 1Vrms and grounding 

the other input OR if you are driving both inputs with 0.5Vrms. In both cases, you are hitting the ADC 



QuantAsylum QA401 User’s Manual 
 

 

 Page 
9 

 
  

with the same differential voltage. That is, the differential input of the ADC is seeing 0.5Vrms on each 

input in both cases.  

Rear Panel Summary 
The rear panel has a single USB connector. This is designed for high speed (480Mbps) USB connections. 

The device consumes between 500 and 600 mA during normal operation. The device is not sensitive to 

USB voltage variations.   

Note that newer computers may employ very strict current sensing on the USB power flowing out of the 

USB port. When the current exceeds a bit over 500 mA, the PC hardware might signal a fault.  

If you suspect your PC has strict limits on the power, then you can use a USB Y connector. These are 

connectors that plug into 2 USB ports and allow USB hardware to pull up to 1000 mA. One of the USB 

ports has no data connection. It just takes power from the second port.  

Alternately, most low-cost USB hubs that are self-powered do no sensing or limiting at all.  

Electrical Characteristics of the Connectors 

BNC Inputs 

The 4 inputs pass through a 33uF series capacitor, followed a series 100 ohm resistor, and followed by a 

resistor divider with a total impedance of 100K ohms.  The corner frequency of this input network is 

about 1.6 Hz. 

The input DC blocking capacitor is polarized, with a 50V rating. The DC blocking capacitor can withstand 

a negative voltage of 15%, or 7.5V, for 125 hours. In general, we recommend you limit the long-term DC 

level (relative to ground) to just a few volts, keeping in mind that the capacitor will degrade over time 

depending on the magnitude of the voltage.  

The input stage will be clamped to the internal input rails (about +/-6.5V) through the 100 ohm input 

resistor. The input attenuator is very fast. We’ve tested overload conditions of 70Vpp for hours on end, 

with no impact noted to the performance of the device. During overload, the system will detect the 

excessive input and engage the attenuator. After 1 second, the attenuator will be released, and the 

input level again checked. This cycle will repeat indefinitely. Of course, the audible indication of the 

relay clicking every second should alert you that the input voltage is too large and to manually engage 

the attenuator.  

IF YOU GOING TO APPLY A HIGH DC BIAS TO THE QA401 INPUTS, YOU MUST MAKE ABSOLUTELY SURE 

THE ATTENUATOR IS ENGAGED. SEE THE SECTION ON MEASURING POWER SUPPLY NOISE COVERED IN 

RMS MEASUREMENTS.  

DO NOT EXCEED THE RATED MAX INPUT VOLTAGE OF THE Q401. IT CAN RESULT IN PERMANENT 

DAMAGE TO THE QA401. 
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NEVER USE THE QA401 TO MEASURE CIRCUITS THAT USE POTENTIALLY LETHAL VOLTAGES. 

The default state of the input is that the attenuator is engaged. That is, when the device is unpowered, 

the attenuator is active. When you first connect the device, regardless of UI setting, the attenuator will 

remain active (attenuating). And when you close the QA401 application or unplug the QA401 hardware, 

the attenuator will always re-engage.  

DO NOT ROUTINELY LEAVE THE QA401 CONNECTED TO ACTIVE SIGNALS WHILE THE QA401 IS POWERED 

OFF. ALWAYS DISCONNECT THE INPUT SIGNALS IF YOU ARE GOING TO POWER DOWN THE QA401. 

BNC Outputs 

The output op-amps have a 47 ohm series R in an 0603 form factor. If the output is accidentally 

connected to a voltage more than few volts in magnitude, the 0603 resistor could act as a fuse and open 

or the output op-amps could be damaged. 

All 4 outputs are DC coupled, with a typical offset between + and – of a few millivolts.  Beginning in the 

1.5 release of the software, a trim function is provided to allow the user further null the offset. You 

should be able to achieve a few 10’s of microvolts of offset between the differential outputs. See the 

section on using the trim function for more information. 

USB Input 

The USB input is designed to operate with the maximum and minimum voltages specified by the USB 

Implementers Forum, which is 4.75V to 5.25V. The noise performance of the analyzer should be 

unchanged to down to 4V DC USB. Below that, certain regulators may begin to drop out and noise 

performance might be impacted.  

Do not exceed the 5.25V upper limit. Most hubs and equipment designed for USB will automatically 

handle this for you.  

Software Installation 
Before plugging in your analyzer, you need to install the software. To do this, download the latest 

installer package from QuantAsylum.com (see the Support → Downloads page) and run the installer. 

Once installed, you may plug your analyzer into the USB connection on your computer.  

The software no longer supports Windows XP, and we cannot help troubleshoot any issues you are 

having with XP. Vista will probably work, but we cannot help trouble shoot any issues you are having 

with Vista. 

If you are running Vista or Windows 7 (32 and 64-bit version), the drivers should install automatically 

when you plug your board in. 
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X32 and X64 Installation 
The drivers are signed, and on Windows 7 and later the installer will be able to auto-install the USB 

drivers. This means that if you install the program and drivers, and then run the program and then plug 

in the analyzer, everything should be taken care of automatically. 

Calibration 
The QA400 product, which was the predecessor to the QA401, required calibration by the user. This was 

because the manufacturing window of the parts used could be fairly large (+/-25%). The QA401, 

however doesn’t need calibration and will deliver outstanding accuracy out of the box.  

Verifying Calibration 
Calibration should be verified from time to time. The procedure is simple and requires a DVM with 

trusted accuracy. Generally, quality DVMs will hold their stated accuracy for a decade or more easily, 

because the drift and aging associated with the internal references used are very low. But quality DVM 

manufacturers will also allow you send in your DVM and have it re-calibrated certified to be operating 

correctly for a fee.   

Using a DVM with a calibration that you trust, perform the following steps: 

1) Use the Settings → Generate Fixed Tone menu option to generate a 0 dBV signal at 60 Hz. Note 

the amplitude. It should be 1.000Vrms +/- 4% (0.96 to 1.04Vrms) on all 4 output ports of the 

QA401. This is a single-ended measurement, with one input to the DVM taken from the center 

of the BNC, and the other input to the DVM taken from the BCN outer conductor.  

2) Repeat the measurement used in step 1), except this time generate a 1 KHz signal. Most DVMs 

will show a very small reduction in reading (few %) between 60 Hz and 1 KHz. This is attributable 

to the natural roll-off of the meter’s response. If your DVM shows more roll-off than a % or two, 

then make a mental note that your DVM is not suitable for direct measurements at 1 KHz and 

the calculations below should be adjusted accordingly. Most meters are specified at 60 Hz, and 

the upper corner isn’t generally published by the DVM manufacturers. Thus, it’s important to 

know.  

3) Cancel the fixed tone generation and connect the + output L of the QA401 to the + input L of the 

QA401. Short the – input.  

4) Select File → Reset startup defaults. This will put the analyzer into a known state. 

5) Set windowing to Flat Top, Atten Off, RMS Measurement, and dBV axis settings 

6) Set Gen1 to 1 KHz, 0 dBV 

7) Verify the input PeakL is 0 dBV +/- 0.1 dB 

8) Apply the attenuator. Verify the signal is 0 dBV +/- 0.15 dB. 

9) Activate the Right Channel and turn off the Left channel in the Display Options section of the UI. 

Repeat the above steps for the right channel. 

To verify the attenuator is working as expected, perform the following steps: 
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1) Select File → Reset startup defaults 

2) Select RMS Measurements and dBV Axis Settings 

3) Enabled Gen1 for 1 KHz and -10 dBV 

4) Note the Peak L amplitude. It should be -10 dBV +/- 0.1 dB 

5) Engage the attenuator. You will see a notation “Atten: 20 dB” appear on the display. Note the 

PeakL amplitude again. It should be within +/- 0.1 dB of the value noted in the previous step. 

Note that the displayed value is -10 dBV again, because the device takes the attenuator into 

account. 

6) Repeat the steps for the right channel. 

If your QA401 is operating outside of the windows specified above, then please contact 

Support@QuantAsylum.com so that we can evaluate this together. Do not rely on the calibration 

adjustments described below to try and adjust for errors that are larger than expected. 

Calibration Adjustments 
There is a file that resides in you’re My Documents folder under the QuantAsylum\QA401 directory. The 

file is named CalibrationData.xml. The contents of this file are parsed at startup of the QA401 

application. Once read, the file isn’t needed again until the next re-launch. So, if you ever make manual 

changes to the file, you must re-launch the QA401 application to re-parse the file. 

In general, there is no reason to make adjustments to the calibration file! This detail is provided here 

for advanced users with unique requirements, or for users that are interested in eliminating the last % 

or two of error. If you ever doubt the accuracy of the calibration file, just delete it and a new default 

will be created. 

There might be a few reasons for making changes to the calibration file. First, you might want to tweak 

for different output impedances. As the QA401 has a 100K AC input impedance, if you are using a source 

impedance that is 50 or 100K, then it might make sense to keep a calibration file around for Hi-Z 

equipment and low-Z equipment. This could be done by renaming the file and swapping names as 

needed before launching the QA401. 

A typical file might appear as follows inside: 

 

mailto:Support@QuantAsylum.com
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Notice there are 4 numbers: two output numbers, and two input numbers. The output numbers 

(OutputCal) are the value the output will be multiplied by before being sent to the DAC. If you want to 

increase your output value by just a bit, you can increase the OutputCal figure by whatever amount you 

wish.  

Similarly, the InputCal is the amount the input will be multiplied by to get it where it needs to be to 

deliver the precise dBFS level. You may also adjust these values as you see fit. As with the output value, 

a single calibration value is used for both left and right. You can put in a separate value for left and right 

if you see fit.  

If you corrupt the contents of the file, the QA401 software will be unable to parse the contents and it 

will create a new file, overwriting the corrupt file.  

You can delete the file at any time, or re-calibrate at any time. Re-calibration will overwrite any existing 

calibration file.  

Attenuator Adjustments 

The QA401 attenuator is built from 0.1% resistors, and should be nominally 20 dB. The software 

assumes it is 20 dB precisely, but this can be changed. The real attenuator value may vary +/- 0.06 dB 

depending on resistor variation. To fine-tune the attenuator, perform the following steps: 

1) Select File → Reset startup defaults 

2) Select RMS Measurements and dBV Axis Settings 

3) Enabled Gen1 for 1 KHz and -10 dBV 

4) Note the Peak L amplitude. 

5) Engage the attenuator and again note the Peak L amplitude. 

6) Take the un-attenuated reading and subtract from that attenuated reading. This is the 

attenuator correction factor. 

7) Close the QA401 application. 

There is a file in the My Documents\QuantAsylum\QA401 directory called Default.Settings. Around line 

53 of the file you will see the following: 

 

The AttenVal is what we’ll adjust. Take the default value of 20 and add to that the attenuator correction 

factor you calculated above. For example, if your correction factor was 0.08, then you would replace the 
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20 with 20.08 as shown below. Close the file and restart the QA401 and verify the Peak value is the 

same  

 

Note that there is a single correction value for the attenuator. You must decide if you’d like to split the 

difference between the left and right channel OR if you’d like to dial in one channel precisely.  The 

channel to channel variation is generally quite small (<0.02 dB). 

QA401 Basic Controls 
The QA401 application is shown below. On the left side of the screen is the display area, and on the right 

side is the control panel.  

 

If your screen height becomes limited, you can click and drag anywhere in the control region that there 

isn’t a control. This will let you scroll the control region to hide some controls and reveal new controls. 

This will work with both your mouse and with a finger if you have a touch screen. 
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Adjusting Knobs 
Knobs are used to permit quick and accurate adjustment of controls. If you are familiar with pro-audio 

production software, then the knobs will already be second nature. In these environments, users must 

deal with literally hundreds of adjustments shown on the screen simultaneously, and an enormous 

amount of refinement has gone into making them useful. 

If you have a mouse with a scroll wheel, then you can hover over a knob, click with your mouse and 

move the mouse wheel to turn the knob. When you are done with the adjustment, move the mouse 

away from the knob. Note that when the mouse moves over the knob and is clicked, the knob features 

an LED that illuminates slightly. This is your cue that adjustment is then possible. 

 

While adjusting the knob, there are a few keyboard shortcuts that can help. 

If you hold the CONTROL key down while adjusting the mouse wheel, the knob will spin 10 times faster 

than if no key were pressed. This makes it easy to quickly adjust something like the offset knob. 

If you hold down the ALT key while adjusting the mouse wheel, the knob will spin 10 times slower than if 

no key were pressed. This makes it easy to fine tune very precise settings. 

Adjusting Without a Mouse Wheel 

If you don't have a mouse wheel or if you are working on a laptop, then you adjust a knob by clicking on 

the knob, and then moving the mouse up or down while holding the click. On a track pad, then you 

would slide your finger up and down while holding the left mouse button. When you are done with the 

adjustment, just release the click. The same accelerator keys (CONTROL and ALT) work using this 

method too. 

If you have a touch screen, then you can place your finger on the knob and slide it upwards or 

downwards to adjust. 

Notice that the knobs don’t have any indication of the value. The knobs are analogous to “rotary 

encoders” used on equipment where the knob can spin forever in a clockwise or counterclockwise 

direction. The actual values being adjusted by the knob are displayed on the analyzer display. This might 

take a little getting used to, but it’s very quick with a little practice, and allows a large set of controls to 

be placed in a small area.  
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Context Menus 
While perusing the QA401 menus, you’ll likely notice they are very sparse compared to other signal 

analyzers. This is because the QA401 makes extensive use of context-sensitive menus. Functionality is 

grouped under the various buttons that enable that functionality. 

Take a look at the example below. Here we the dBV button, for example has a dot in the lower left 

corner. If we want to bring up a context menu related to the dBV settings, we can click on that button 

while holding the control key down. If a button doesn’t have a dot (such as the dBFS button), then it 

means the button doesn’t have a context menu. 

 

Control-click on the dBV button yields the following menu: 

 

This is a very important concept related to the QA401 interface: Settings related to a particular function 

are adjusted in a context menu, and that context menu is activated by control-clicking the button. 
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Control Overview 
There are a few basic control groupings on the analyzer, and these are covered below.  

Run/Stop Button  
The Run/Stop button is prominently located at the bottom of the control panel. This button starts and 

stops the analyzer acquisition, although that can also be accomplished with the space key (see the 

section on soft keys). In the first picture below, you can see the analyzer expanded to full screen, and 

the yellow box highlights the Run/Stop button 

 

Next to the Run/Stop button is the attenuator button. When this button is lit, it means it is active and 

thus the 20 dB input attenuator is active.  

 

Display Options 
The buttons below determine what is shown on this display.  



QuantAsylum QA401 User’s Manual 
 

 

 Page 
18 

 
  

 

The time button displays the transmitted and captured waveforms in the time domain. With the time 

and input button pressed, we can see what was captured by the analyzer. Sometimes you can forget 

that you are looking at the output data. The output data is exceptionally clean and might confuse you 

into thinking that you are looking at test data from the device under test. For this reason, when you 

have selected to look at the output data, you will be reminded with an on-screen indication that you are 

viewing output data.  

Below, we can see the input data in the time domain. 

 

Similarly, we could push the output button and see the signal that was transmitted by the analyzer. If we 

zoom in on the transmitted waveform (by dragging to the region we want to see using the left mouse 

button), then we see the output waveform has 3 distinct regions.  
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The same waveform above is shown below with some boxes highlighting the different regions. 

 

The green box shows the ramp up period of the output waveform, the red region shows the constant 

amplitude portion, and the blue region shows the ramp down region. 

At this point, it’s important to highlight that the QA401 does not operate with constant stimulus tones. 

The QA401 operates with stimulus bursts. The reason for this is to ensure that the full transaction with 

the hardware can be treated as a discrete event with a clearly defined start and stop point. Each 

transaction can start from a known state, and finish in a known state, and if various checkpoints along 

the way are not met, then the transaction can be counted as flawed and the results can be rejected.  
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The ramp up period of the waveform allows the various output audio stages external to the QA401 to 

stabilize their DC operating points. This gentle ramp also ensures audible pops are avoided that might 

harm power output stages.  

The constant amplitude region is the region over which the FFT will actually be computed.  

The ramp down region ensures again that a sine wave isn’t terminated mid cycle which might also result 

in a click or pop, and it ensures the DC level is gently returned to zero. 

Normally, you’ll be looking at the display with the following buttons pressed: Freq, Input and Left and/or 

right. This will show you the captured FFT data on the incoming signal.  

 

When the right button is pressed, as shown above, the display will show the right channel data in the 

color red. Below, we see the left channel data shown in yellow, and the right channel data shown in red. 

And of course, if we only wanted to show right channel data we would simply turn the left display off by 

pressing the left button. 
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Axis 
The axis controls select our units for the Y axis, and allow us to adjust the X and Y axis settings. Below we 

see this control groups. The top 3 buttons set our Y Axis units. The dBFS button shows absolute units 

relative to the ADC and DAC maximum output levels.  

dBFS, dBV, and dBr Buttons 

The dBV button shows our levels in absolute RMS voltage levels relative to 1Vrms.  

And the dBR button allows us to display arbitrary levels relative to whatever we pick as a reference. 

 

Since the dBFS levels are absolute, there is no adjustments to be made via context menu. 

dBV Context Menu 

The dBV levels are also absolute, but in dBV mode we can specify whether or not external gains are 

attached to the inputs and outputs, and we can also opt to render the peaks in watts if we specify the 

impedance connected. 

 

Note that input gains will adjust all displayed data upwards the gain amount. In other words, if you 

specify that you have a 0 dB external gain, then 1Vrms signal will be reported as 0 dBV. But if you specify 

that you have a 10 dB external gain, then that same 1Vrms signal will be reported at 10 dBV. For both 

input and output external gains, the correct way to think about the settings is that if you have non-zero 
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gains specified, then the values displayed on the screen will reference the levels on the other side of the 

gain block, as shown below.  

 

The absolute peak levels are reported on the screen regardless of the Y Axis settings. In the case below, 

you can see the peak levels are also reported in watts because we specified an 8 ohm impedance. This is 

useful for seeing the displayed power from a power amplifier.  

 

dBR Button and Context Menu 

The dBR context menu is shown below.  
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There are 4 ways to specify the absolute level from this menu. 

The first is that you can specify the 0 dB reference point directly by entering the dBV setting that 

corresponds to the new 0 dBr setting. 

Next, you can specify that the current on-screen peak will become the new reference point, and you can 

specify the level that peak will be. Let’s say, for example, that you have an input attenuator of roughly 

10:1 in place, and you are measuring the output of an amplifier. You adjust the amplifier output so that 

you measured 5Vrms with your DVM (about +14 dBV). You are then left with a level of roughly -6 dBV 

coming into the analyzer. If you specify that the peak level is 14 dBr, then the display will indicate the 

same as the absolute value you measured with your DVM. 

The next two buttons are shortcuts to the above two methods.  

The first button allows you to declare the current peak is the new 0 dB reference. 

The second button allows you to declare the value measured at 1 KHz is the new 0 dB reference. This is 

handy when looking at Frequency Response and normalizing the response to 1 KHz. 

X Lin/X Log Buttons and Context Menus 

The X Lin button specifies that we want to view the X Axis with a linear scale, while the X Log buttons 

specifies we want to view the X Axis with a log scale. 

The screen captures immediately above have shown the log setting, while this shot below shows the 

linear setting. 
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The context menus for both the log and linear settings button allow you to set start and end display 

frequency. The linear button also allows a center frequency and span to be set 

   

Recalling again the Axis controls, the purpose of the default button is to permit you to zoom to your 

default settings after scrolling or panning the display area. The Y Min and Y Max knobs allows 

adjustment of the Y Axis settings. 
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Display Panning and Scrolling 
You can zoom to details in the display area using the left mouse button. Click the upper left region you’d 

like to highlight, and drag to the lower right region. You’ll see a box drawn to show you area that will be 

zoomed. Upon releasing the drag, the new area will be zoomed. 

You can pan around the display area by dragging with your middle mouse button. Below, you see a 

detailed zoom of the display. Press the Default button in the Axis controls to revert to the normal display 

settings when you are done zooming. 

 

Titles and Markers 
Titles can be added to the graph by right clicking in the display area. This will bring up a context menu 

and the first menu option will permit you to add or edit a title. 
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The title will appear above the graph region, and below the measurement data. 

 

Adding Markers 
Markers are useful for measuring amplitude differences in signals you see. They are also accessed via 

the display context menu. The simplest way to add a marker is to hover over the peak of interest and 

then press the ‘m’ key or you can click the peak with the mouse. Alternately, you can hover over the 

peak and the right click and select the Add Marker menu item. When adding markers, think of the 

distance to nearest trace feature rather than your Y location. When you add a marker, the software will 
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look for the nearest trace feature and NOT the current Y value. This means if you are to the right of a tall 

peak and add a marker, the marker will be added to the tall peak and NOT the current Y position. 

 

If you add a marker in an unexpected place, you can click on the marker and remove it, or you can 

remove all the markers via the graph area context menu (activated by right clicking in the graph area). 

 

Markers details will show up in the display area. This allows us to the see the frequency of each marker, 

the absolute amplitude of each marker and the relative amplitude of each marker. Note that markers 

are always sorted according to amplitude. The strongest signal will always be listed first, then the next 

strongest, etc. This makes it very easy to quickly see the amplitude of each signal relative to the 

strongest signal.  
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Tracking Markers 

Tracking markers are not in the current release.  

Acquisition Control 
The acquisition settings determine the resolution of your capture, and also how much filtering is 

performed. 

 

The resolution knob can be adjusted to show the level of detail you require. More detail takes more 

time to capture. The averaging knob determines how many samples are averaged when the display 

values are computed. Note that averaging doesn’t change the noise floor, but it does make it easier to 

see signals that might be buried in noise. Since long averaging can delay the time it takes to see changes, 

there is a reset button. This is helpful if, for example, you change the input frequency. In this case, you 

can push the Reset button and immediate see the new average get built. Without this, you’d have to 

wait to see the old signal average decay away. 

As you adjust the resolution and averaging, the parameters below are updated in the display.  
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Weighting 
Weighting can be applied to measurements if needed. While there are a lot of different weighting 

functions defined, most are seldom used. The most commonly specified weighting function is A 

Weighting, which attempts to adjust for the loudness as perceived by the human ear. Because the ear is 

less sensitive at lower and higher frequencies, the weighting works to attenuate the values below 

roughly 1 KHz and above 4 to 5 KHz or so.  

 

On the QA401, weighting can be applied or removed by pressing the A weighting button, or the Off 

button. When the Off button is selected, then no weighting is applied to the displayed data. When the A 

button is selected, then the A weighting is applied. Notice that at 1 KHz, the A weighting has a gain of 0 

dB, thus a 1 KHz signal will have the same amplitude whether or not weighting is applied.  

Wikipedia lists the response curves for the various weighting function as follows: 
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Windowing Functions 
The FFT process assumes the captured data repeats infinitely. If the data sent to the FFT function 

contains, for example, 10.5 cycles of a waveform, then the extra half cycle will causes errors in the 

resulting spectrum. To get around this, a windowing function is applied to the data. This function will 

gently taper the amplitude of the collected data (prior to FFT) down towards 0 near the start and finish 

of the sample buffer. By doing this, the extra half cycle that appears to immediately truncate will be 

suppressed. The downside to this is that some other distortions will be introduced into the displayed 

spectrum. But the introduced distortions are much less objectionable than the distortions that arise 

from an abruptly terminated waveform. 

Using the input display feature on the QA401, we can look at this in more detail. Using a small buffer 

(512 samples) and low frequency waveforms, we can see what truncations can do to our data. For these 

tests, we set the windowing function to Rect (which means no windowing is applied). 

First, let’s look at a 10 Hz waveform at 16K points, 48Ksps. We can see the input waveform below 
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Notice the right side of the waveform above is chopped off. With windowing turned off (Rect), we see 

the resulting spectrum below. Notice how much energy there is across the entire band, even after 10 

KHz. This is due to the truncated waveform.  

 

But if we switch the windowing to Hann, the energy at higher frequencies is suppressed 
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But what if we pick Flat Top windowing? What do we see then? The response looks worse again. What is 

happening? 

 

It turns out that windowing functions are very complex, and you should set them based on what you are 

trying to measure. Any window option you pick will be a balance between resolution, leakage/dynamic 

range and ripple. 
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The QA401 supports 5 basic windowing functions as shown above: 

Rect This is also commonly called Rectangular, boxcar, uniform, or no windowing. This is most 
useful when you can precisely ensure you have collected an integer number of cycles of 
the waveform. When you can do this, you can then apply no windowing and introduce the 
minimum amount of distortion to your displayed data. This is the reason you see ADC data 
sheets measuring odd frequencies at odd sample rates. They are striving to capture an 
integer number of cycles so that they can apply no windowing. Under these conditions, 
the Rect can deliver excellent results for ripple, dynamic range and resolution. 

Hann The Hanning window provides a great balance between ripple, dynamic range and 
resolution for all sorts of signals. It does have about 0.6dB of ripple. If amplitude accuracy 
is important, then consider Flat Top. 

Bartlett The Bartlett window is similar to Hann, with worse leakage and frequency resolution. 
Generally, unless a procedure calls specifically for this window, you’ll want to use Hanning. 

Hamm The Hamming window is similar to Hann, but with a bit more spectral leakage. Generally, 
unless a test procedure calls for this windows specifically, you’ll want to use Hanning. 

Flat 
Top 

For accurate amplitude measurements, the Flat Top is the best choice. On the QA401, 
you’ll generally see less than 0.05 dB of amplitude variation using this selection. 

 

Measurement Types 

Definitions 
The QA401 makes basic audio measurements quickly, can perform more advanced sweep-type 

measurements and can permit 3rd party applications to control the QA401 for even more sophisticated 

measurements. 

Basic audio measurements usually involve terms such as SNR, THD and SINAD. But often it can be 

confusing to remember what each measurement refers to precisely. The purpose of this section is to 

clarify the meanings as incorporated in the QA401. The Analog Devices app note MT0031 is an excellent 

write-up on the topic. 

Total Power is defined as the RMS of the spectrum bounded by the user-set Measurement Start and 

Measurement Stop parameters. 

                                                           
1Kester, Walt, Understand SINAD, ENOB, SNR, THD, THD + N, and SFDR so You Don't Get Lost in the Noise Floor, 
Analog Devices MT-003 
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N+D (Noise + Distortion) is defined as the Power Measurement minus the power contained in the 

fundamental. The fundamental is defined by the user, and can be either the frequency setting in the 

Signal Generator 1, or it can be the highest peak, or it can be a user specified frequency. If the input is 

disconnected, then a fundamental won’t be present and the N+D will match the Power reading. 

THD (Total Harmonic Distortion) is the ratio of the RMS signal power in the fundamental to the RMS sum 

of the harmonics. The harmonic is selected to be 2x, 3x, 4x…n of the fundamental, up to the 

Measurement Stop setting. So, if you have a 1 KHz fundamental, and a 20 KHz Measurement Stop 

setting, then the QA401 will measure up to and including the 20th harmonic. Similarly, if you have a 10 

KHz fundamental and a 20 KHz Measurement Stop setting, then the THD will only reflect the 2nd 

harmonic.  

THD+N (Total Harmonic Distortion + Noise) is the ratio of the RMS signal power to the Noise + Distortion 

as defined above.  

A more concise way to look at this is to consider the following definitions: 

Nnyq = This is the root-sum-square or all components, from the Nyquist Frequency down to (but 

not including) DC 

N = Noise. This is the non-signal and non-harmonic  signals contained in the specified spectrum. 

More specifically, this is the root-sum-square of the non-signal and non-harmonic signals.  

D = Distortion. This is the sum of all harmonic peak values, not including the fundamental, up to 

the Measurement Stop setting. Note that the QA100 will only consider up to 100 harmonics.  

S = Signal. This is the peak level of the signal. 

SNR = 20log(S/Nnyq). This is the log ratio of the signal to noise. What is important here is that the 

noise does NOT include the harmonics. Note that on the QA401, the SNR reading does not 

automatically include all of the noise up until Nyquist. The SNR reading on the QA401 respects 

the setting of the Measurement Stop frequency. To get a true SNR reading, you must ensure 

that Measurement Stop is set to the Nyquist frequency. 

SINAD = 20log(S/(Nnyq+D)) 

THD = 20log(S/D) 

THD+N = 20log(S/N+D)) 

QA401 Measurement Types 
There are 4 basic measurements that can be done by the QA401. The measurements require the button 

to be pressed for the measurement result to be displayed. This is done for two reasons. First, each 

measurement takes time to perform. And second, showing a measurement on a presentation slide that 
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isn’t germane to the topic at hand can cause confusion. So, for this reason, you should only the 

measurements you wish to display, especially if you are going to share the data with others. 

 

RMS/Power 
The RMS (formerly Pwr) button refers to the power measurements. When this button is selected, the 

power will be computed across the specified measurement start and stop span. In the plot below, we 

can see a few key pieces of data related to this measurement. First, we can clearly see the measurement 

is performed over the 20 to 20 KHz interval. Next, we can see the total power measured in this interval 

is – 60 dBV. Since the noise is so far down below the signal, this makes sense. Next, we can see that 

noise and distortion (N+D) is -99.5 dBV. The N+D measurement is the measured power in the specified 

20 to 20 KHz interval, but it DOES NOT include the power contained at the generator frequency. If the 

generator is turned off, you’ll see the Total Power matches the Noise and Distortion power.  
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A common measurement is to measure the noise floor of an output circuit. If the output circuit has a 

voltage in the range of +/-5V, then the measurement can be made directly on the QA401 by applying the 

voltage to the BNC input terminals without regard for attenuator setting. Most line-level opamp 

amplifiers and battery powered headphone amps fall into this category. Even high-power class D 

amplifiers will do a very good job of ensuring high-voltage transients are not present on the outputs. 

Another common measurement that might be made is measuring the output noise of a power supply. 

This requires careful consideration, because if the voltage exceeds 6 or 7V and the attenuator is 

disengaged, then very high transient currents can flow inside the QA401 and potentially damage the 

device performance.  

The correct way to think about this is by the peak currents involved. If the attenuator is engaged, then 

there is no concern about the peak currents and the +50V/-7.5V cap rating applies. If the attenuator is 

NOT engaged, then a momentary current will flow through the input capacitor, through the 100 ohm 

current limiting resistor through a protection diode clamp, and then it will be clamped to the +/- 6.5V 

supply rails, limited by the 100 ohm resistor.  

The max clamp current should be limited to 10 mA. If an external DC voltage of +/-7.5V is applied, this is 

roughly a 10 mA transient current. In other words, measuring a power supply’s noise with an output 

greater than 7.5V requires special consideration. 

The easiest way to solve this is to use the built-in attenuator. Even at +50V DC (the limit of the input 

capacitor), the attenuator will limit peak transient currents. However, if you are concerned about 

forgetting to engage the attenuator OR you need a noise floor that is better than the noise floor offered 

with the attenuator engaged, then an external current limit resistor can solve the problem.  

As an example, to measure a 15V power supply, we want to use a (15-6.5) / 0.01 = 850 ohm resistor in 

series with the input. Rounding up to 1K is fine, because the thermal noise from a 1K resistor in a 20K 

bandwidth will be about 0.6 uVrms, and a really good power supply output noise value in the same 

bandwidth will be 15 uVrms.  

FOR MEASURING THE NOISE OR SPECTRUM OF EXTERNAL HIGHER VOLTAGE  OUTPUTS (GREATER THAN 

5V IN MAGNITUDE OF DC BIAS), MAKE SURE A CURRENT LIMITING RESISTOR IS USED IN IN SERIES WITH 

THE INPUT TO LIMIT THE MOMENTARY CURRENTS TO NO MORE THAN 10 mA. MISTAKES HERE ARE NOT 

COVERED UNDER WARRANTY. 

THD 
The THD measurement is enabled by pressing the THD button.  

The THD measurement will measure the ratio of all the harmonics of the fundamental (up to 100 

harmonics maximum). Note that there are 3 ways to specify the fundamental frequency. You can use 

the settings on the first signal generator, or the highest detected peak, or a specific frequency. These are 

covered in the context settings below.  
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In the plot above, we can see the second harmonic is about -107 dB below the fundamental. If we use 

markers, we can see this a bit easier below. The THD function will sum the harmonic powers all the way 

up to the specified Measurement Stop. In the plot above, the sum of the harmonic power is -107.1 dB. 

To go from a dB measurement to a percent measurement, use the following: 

THD pct = 10^(THDdb/20) * 100 

This is done automatically in computing the % distortion figure.  
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One thing to keep in mind is that the Measurement Stop value sets the upper harmonic to be 

considered. If you are looking at a 1 KHz signal, then a 20 KHz stop value means you will look at all 

harmonics up to the 20th harmonic in your THD calculation.  

But what if you have specified an 11 KHz signal? In that case, the second harmonic will be at 22 KHz, 

which is beyond the 20 KHz Measurement Stop limit. In that case, the second harmonic will never be 

seen, and the THD value won’t make much sense. In the example below, we can see a marker at 11 KHz 

and 22 KHz, and since the Measurement Stop is set to 20 KHz the second harmonic is never seen.  

 

THD Context Menu 

The THD context menu is very simple, and allows you to set the Measurement Start and Stop limits. 

Note these are the same limits that are set in the Power context menu. Additionally, you can specify 

what will be used for the fundamental.  
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Because the fundamental selection is so important, it’s important that you can readily see what the 

software has selected for the fundamental frequency. Notice below that a small green ‘F’ has been 

drawn near the X axis. This way you can be certain that the software is picking up the peak you want, 

and not some other signal. 
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THD + N 
The THD + N measurement is enabled using the button on the panel. THD+N is similar to the THD 

measurement, but instead of looking at just the harmonic power, all of the non-fundamental power is 

considered in the specified bandwidth.  

 

 

Notice the relationship between the highlighted numbers above. The peak value is -10 dBV (which is the 

level of the signal generator), and Noise + Distortion is measured as -95.5 dBV, and thus this means the 

ratio of the signal to the noise and distortion is -85.5 dB, which is what is reported in the THD+N 

calculation. 

Frequency Response 
The QA401 offers a quick way to look at the frequency response of a device under test (DUT). This is 

achieved with the Frequency Response (FR) button. The context menu for the Frequency Response 

button appears as follows: 
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There are five types of stimuli available:  

Impulse The impulse response is a single sample centered in the output buffer with the 
specified amplitude. Because the energy of an impulse is so low, it’s primarily useful 
in evaluating circuits that are directly wired to the QA401. Attempting to measure 
frequency response with an amplified impulse played through speakers and captured 
by a microphone can be challenging because there is so little recovered energy.  

Expo Chirp This is an exponentially swept sine, covering 10 octaves, with the final frequency 
being 0.9 * Nyquist. This chirp will change based on sampling rate.  

Linear Chirp This is a linear swept sine, swept from 20 to 20 KHz regardless of sample rate. 

Farina Chirp This is an exponentially swept sine following the formula specified by Farina, with a 
start frequency of 20 Hz, and a stop frequency of 20 KHz regardless of sample rate 

White Noise This is white noise originated from the DotNet random number generator.  

 

It is well known that an impulse response has an infinite frequency spectrum. If you present a perfect 

impulse response to a DUT, then the output from the DUT will be the response of that device. And we 

can take the FFT of that response, and from that learn the frequency response of the DUT. 

NOTE: When looking at spectrum of the above stimuli, you generally want to be using RECT windowing. 

Otherwise, the shape of the spectrum will be distorted by the windowing function.   

If we connect the output to the input of the QA401 and look at the output time spectrum, we can see 

the impulse response. The plot on the left shows this output zoomed in so that we can see the single 
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sample impulse. The right plot shows the entire output buffer, and the position of the impulse

 

Looking at the input frequency, we see a flat line at an arbitrary amplitude. The amplitude depends on a 

variety of settings and the response of the DUT. In the plot below, we are in pure loopback mode.  

 

To make the plot above useful, we’ll switch to dBr mode, and use the dBr context menu to set the 1 KHz 

level to our new 0 dB point 
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With this new reference point, we can zoom in and see the loopback frequency response of the QA401 

at 192Ksps. In the plot below, the 3 dB point is roughly < 1 Hz to nearly 80 KHz. This is easily measured 

by stopping the capture, and then looking at the values displayed by dragging the mouse cursors on the 

screen. 
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Zooming in a bit more, we can see the response at 20 Hz is roughly 0.05 dB and the response at 20 KHz 

is roughly down 0.1 dB, both relative to 1 KHz.  

 

Similar procedures can be followed for the white noise stimulus. The white noise stimulus can be a bit 

noisy, and is best used with heavy averaging—both large FFT sizes and signal averaging. As discussed 

above, the impulse measurements are most helpful when characterizing circuits wired directly to the 

QA401. The white noise might be more useful when playing the stimulus through a speaker and 

capturing it with a microphone. 

All of the chirp stimuli are considered experimental at this point. The way these would be used now 

would be to capture the input waveforms using an external application and then using the external 

application to process the captured waveform.  
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Generators 
The QA401 has two tone generators. Each tone generator has knobs so that the mouse can control the 

amplitude and frequency settings. This is useful when you are interactively looking at circuit 

performance and want to change values on the fly.  

 

The generators are enabled using the Gen1 and Gen2 buttons. Each generator also has a context menu. 

From the context menu, you can set a precise frequency. If you select “Round to Eliminate Leakage”, 

then the frequency you select will be nudged a bit higher or lower to ensure that it sits precisely in the 

center of a frequency bin. This will dramatically reduce the amount of leaking you are seeing. Generally, 

the amount the frequency will be nudged will be no more than the resolution of your current FFT size 

and sample rate.  

 

When the rounding occurring, you will see the rounded frequency in the Generator display at the top of 

the waveform window. In the picture below, we specified a 1 KHz waveform, enabled rounding, and the 

frequency was adjusted automatically to 996.0938 Hz.  
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The amplitude of the generator will always be specified in the current units of display. For example, if 

you have specified dBV, then the amplitude you enter will be in dBV units. When you switch to another 

units (such as dBFS), then value you entered will automatically be converted to the new units.  

 

The frequency and amplitude knob sensitivities allow you to specify how much each value will change 

when you rotate your mouse wheel above the Freq and Amp knobs. And again, if you press the control 

key while adjusting the knob, the knob will spin 10X faster. And if you press the shift key while adjusting 

the knob, the knob will spin 10X slower.  

IMD Measurements 
The primary purpose of the dual-tone generators is to permit IMD measurements. While the QA401 

doesn’t perform automatic IMD measurements, they are easy to perform manually. A typical IMD test 

would be the IMD ITU-R test. This requires applying two tones of equal amplitude spaced 1 KHz apart. 

Usually, the tones are 19 KHz and 20 KHz.  
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In the plot above, you can see the 19 KHz and 20 KHz tones applied at -7 dBFS, and the resultant mixing 

product that shows up at 1 KHz, 2 KHz, etc. As the marker shows, the 1 KHz tone is roughly 100 dB below 

the input tones, and thus the IMD shown is roughly 0.001%.  

Another common IMD measurement is commonly known as the SMTPE IMD measurement. This 

involves a low frequency signal (usually 60 Hz) and a high frequency tone (usually 7 KHz), with the lower 

frequency being 4 times greater (12 dB). Below we see both tones.  
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Notice we’re at 48 Ksps sampling rate and 32K FFT, as this gives us less than 1 Hz resolution. 

 

The region of interest are the IM products around the 7 KHz tone. Zooming in, we can see these in great 

detail, thanks to the high resolution FFT in the plot above.  

Notice the 7 KHz +/- 60 Hz harmonic is tightly suppressed. But the second harmonic of the 60 Hz shows 

up (and +/- 120 Hz) and that level is shown to be about -101 dB below the 7 KHz tone. 
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Power Supply Noise Measurements 
A common measurement to make is the output noise of a power supply. Recall the max DC input limit 

previously discussed: It is critical to keep DC levels within +/-5V at all times, even if the attenuator is 

engaged. Even though the input is AC coupled, connecting higher voltages will cause protection diodes 

to activate for very short periods of time and the brief, high-current flows could damage the input stage. 

The QA401 with the inputs shorted will report a 20 to 20 KHz noise reading of roughly -115 dBV, which is 

about 1.8 uV. This is the lower bound of power supply noise that can be measured. Typical LDOs will 

exhibit noise in excess of 50 uV in the audio band, while ultra low-noise LDOs will approach the limits of 

the QA401 is very rare cases. State of the art today for LDOs is below 1uV in the audio band. 

The safest way to measure the noise of a power supply is to use a resistor divider to drop the power 

supply voltage to under 5V. For example, if you wanted to measure a 48V power supply you could use a 

1/10th divider (20 dB) comprised of a 100 ohm lower resistor and a 900 ohm upper resistor. You’d then 

report in the QA401 an external gain of -20 dB. This would be done in the Axis Settings button marked 

dBV context menu as shown below 

 

This would raise the apparent noise floor of the QA401 to about 18uV. This means that if your supply 

was 48V and had an expected noise measurement that was less than 18 uV, this technique wouldn’t 

work. But higher voltages supplies that require this level of noise are rare. 

For a 15V supply, if you used a 1/3 divider (-9.55 dB), the measurement noise floor would be about 5.4 

uV (20 to 20 KHz) while keeping the input at or below the 5V limit. 

Feel free to contact us at the support email if you’d like help in selecting values for the divider.  
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Settings 
The settings menu allows in-frequent settings to be adjusted.  

General 
The General dialog is used to adjust the system sample rates. The 192 Ksps will be more demanding on 

hardware resources, and as a result might not be usable on older or slower systems.  

 

Display 
The Display tab allows you to set “Dark on Light” color scheme. This is more suitable when you need to 

create plots that can be printed.  
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Other 
The last tab of the dialog allows you to make adjustments for some unique test cases.  

Latency Compensation 

Latency Compensation allows you test devices that might have longer processing delays. For example, if 

you are testing a codec or a system that involves digitization and transmission/reception, then there 

could be 50 mS or more of latency in the path. Because the QA401 operates on bursts, the length of the 

burst might be not long enough. That is, the burst might not have even arrived back at the input ports 

when the QA401 expects it.  
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The solution here is to increase the previously discussed “constant amplitude” region of the burst 

(shown below in red). Before the 1.50 release, the only way to increase the constant amplitude region of 

the burst was by increasing the FFT size. With the 1.50 release and later, the ability to increase the pre-

buffer will permit the burst length to grow.  

Keep in mind the latency compensation depends on the current sample rate. Set your sample rate 

before you adjust the latency compensation, and you will see the max latency computed adjacent the 

pre-buffer setting. If you change sample rate, the buffer size will stay constant, but the latency 

compensation will change. 
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Output Trim 

Output trim allows you adjust the output offset of the DAC. With the QA401 in the Stop mode, you can 

measure the output of a BNC (relative to its outer conductor) and you’ll notice a slight offset around 1 or 

2 mV. By adjusting the output trim, you can null that reading to very near zero. The reading is shared 

among the 4 outputs (Left+ and Left- and Right+ and Right-). The output offset is due to DAC offsets (the 

dominate source) and opamp offsets (generally around +/- 100uV).  
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PC Audio for DAC 

Manual tests on an audio DAC connected to a PC are easy to do, because you can play tones on the DAC 

and measure those tones on the QA401. But automated testing of a DAC requires that the QA401 can 

control the DAC amplitude and frequency. 

When the checkbox “Replicate QA401 output on PC audio” is checked, then the adjustments made to 

the QA401 Gen1 amplitude and frequency will also be made on the PRIMARY audio output device on the 

PC. There are a few things to keep in mind here: 

First, the PC amplitude of the PC isn’t know or calibrated, and thus when you specify a tone level of 

0dBFS, the PC will generate a maximum valued tone, -6 dBV will generate a half value tone, etc.  

Second, the PC PC audio will start and stop along with the QA401 audio. When the frequency or 

amplitude is changed on the QA401, either directly or via the API, the change will also happen to the PC 

audio. 

Finally, keep in mind the PC audio must be the primary audio device in the system AND it must be 

capable of of 44.1 KHz.  

 

Test Plugins 
Test plugs in are tests you can write in DotNet (C++, C# or Visual Basic) that will let you control the 

QA401 to provide automated tests. There are two tests shipped with the system, and these tests 

provide sweeps of THD versus frequency and amplitude, or frequency response at various amplitude.  
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For example, if you wanted to test THD of an amp while sweeping amplitude from -10 to 0 dBV in 2 dB 

steps, and from 10 Hz to 20 KHz at 7 points per octave, you’d fill out the THD measurement as follows, 

hit “start test” and the system could build a list of about 450 measurements to make, and then make 

those measurements automatically.  

 

When the measurements were finished, you’d be presented with a graph as shown below, and the 

option to save the data to a CSV file for analysis in your preferred software.  
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Keyboard Shortcuts 
The following shortcuts are available to speed certain operations. 

The following keys will be useful during your normal work with the analyzer for starting and stopping the 

analyzer, adding markers, etc. Note that in order for the soft keys to work, the program must have 

focus. This means that the window is the active window on the desktop. The best way to ensure this is 

just click at the top of the window and drag it just a bit. 

Key Action 

M This will set a marker at the current peak near the mouse pointer. 

This can also be achieved by clicking on a peak 

D This will delete all visible markers. Deleting an individual marker 

can also be achieved by clicking on the marker 

Space This is the same as the Run/Stop button. Pressing this will toggle 

that state. 

C Captures the currently displayed analyzer display to the clipboard 

 

Troubleshooting 
This section covers common issues that might be encountered while using the analyzer. In addition to 

the information here, please also rely on our forum to quick answers to questions you might encounter. 

Connectivity Issues 
USB, when it works, is a great thing. Plug and Play, when it works, is also a great thing. But figuring out 

why a USB device isn't working can be a very frustrating experience. The steps below will walk you 

through all the steps required to figure out why your analyzer isn't working. 
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Step #1: Make sure you are connected to a high-speed (480Mbps) USB hub 

The analyzer requires the additional bandwidth provided by high speed to meet its performance 

requirements. If you are seeing messages such as shown below, and you are sure you are connected to a 

480Mbps hub, then it’s possible that another device on the hub is slowing the hub down OR a hub as 

become stuck at a slower rate. Remove all other devices from the hub and reboot the computer. 

 

Step #2: Make sure no QuantAsylum applications are running, and then plug in the analyzer and 

confirm the driver is loading properly. 

When you plug in the analyzer, you should hear an audio indication that the analyzer has been plugged 

in. If you do not, plug in another USB device that is known to work and see if that device gives an audio 

indication. If it does not, your audio settings might be too low or muted. 

With your selected hub able to support high-speed (480Mbps) USB, then next step is to plug in the 

QA401 device while the application is not running. After plugging in the QA401, check the Device 

Manager (type devmgmt.msc at the Start -> Run Menu or Start text prompt) and then expand the 

Universal Serial Bus Controllers section. 

This should show a reference to the QA401 Analyzer as highlighted below (although the “development” 

text might not be present. That is fine).  
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If you see something similar to the above, then the drivers has installed correctly. At this point, you can 

move to Step #3. 

If the driver has not installed, then you might have heard some tones indicating there was an issue, or a 

message might have popped up explaining the problem. 

You should see the device listed in the “other devices” section in the device manager. In this case, right 

click on the “unkown device” and verify that this in fact the expected device by inspecting the USB ID. 
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Note you should see the characters “16C0” and “4E22” as shown in the text above. Once you have 

confirmed this, you can move to manually install the driver. Here, you want to tell Windows to let you 

pick the driver, and point it to the USB Driver directory of the installed location. At this point, the driver 

should install itself.  

Step #3: Run the application and confirm it can connect 

At this point, you have confirmed the drivers have been correctly installed, and you can see the Analyzer 

appearing in the device manager as shown below.  

 

Now, start the QA401 application. You should hear the USB connect indications, followed by an 

indication from the Analyzer Application that it has connected to the hardware. If this does not occur, 
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unplug and re-plug the QA401. If it still doesn’t connect, then re-boot your machine. For problems 

beyond that, please contact QuantAsylum support.  
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Appendix I: Test Plugins 
Test plug-ins allow you to write a DLL that can control the QA401 from within the application. This is 

helpful for performing swept measurements—measurements that are repeated over and over with a 

single variable changing. And example of a sweep is shown below. 

 

UI can also be written to allow the user to configure the measurements. Below we see UI that configures 

the plot above.  
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If you’d like to write a DLL plugin, contact us at the support alias and we can provide some sample code  
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Appendix 2: Visualizers 
Content in this section is taken from 

http://www.quantasylum.com/content/Home/tabid/40/EntryId/34/Visualizers-and-Examining-the-

Residual.aspx  

Please refer to that post on line for more detail.  

Background 
Visualizers are plug-ins you can write that permit the author access to the acquired data for additional 

processing. These plugs ins reside in a directory off the main installed directory called “Visualizers”.  

When you add a visualizer DLL to that directory, the Visualizer will shows up in the Visualizer menu 

menu list as shown below.  

 

There is a DotNet interface embedded in the QA 401 executable that appears as below: 

namespace QA400NS 
{ 
    public interface IVisualizer 
    { 
        string GetMenuName(); 
        void Start(Form parent); 
        bool ShowData(VisSettings settings, double[] dataOutL, double[] dataInL, double[] 
dataOutR, double[] dataInR); 
    } 
 
    public class VisSettings 
    { 
        public double SampleFreq; 
        public double Gen1Freq; 
    } 
} 

The visualizer writer must implement three functions: 

GetMenuName() is the name of the interface that appears on the visualizer menu drop down. 

Start() is called when the interface is first loaded. This allows the visualizer to do whatever it needs to 

get setup. Usually, this will include creating a dialog box and positioning it as needed. 

 

http://www.quantasylum.com/content/Home/tabid/40/EntryId/34/Visualizers-and-Examining-the-Residual.aspx
http://www.quantasylum.com/content/Home/tabid/40/EntryId/34/Visualizers-and-Examining-the-Residual.aspx
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ShowData() is called every time the host acquires a new frame of data. 

 

The basic steps to realize a visualizer are as follows: 

1) Using Visual Studio, create a new project that is a DLL 

2) Add a reference to the QA400 application 

3) In your DLL class, inherit from the QA400NS.IVisualizer 

4) Implement the required functions. We’ll discuss that more below. 

5) Create and render whatever UI you want 

See the post referenced at the start of this section for full code samples.  
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Appendix 3: Software API 

Overview 
The QA401 application can be remotely controlled via an external application, making it easy to use the 

QA401 in an environment where repetitive testing can be automated. The underlying technology used is 

DotNet Remoting, which is Microsoft’s way of allowing applications to communicate with each other in 

a discoverable and type-safe way over a networking connection. This means the test application and the 

PC running the QA401 application and be located on the same machine, or they could be located on 

separate machines across the world. In both cases, the software would be identical. 

In the software distribution, there is a file in the API directory called “remotingtest.zip.” Unzipping this 

file will reveal a test application that shows how the remote connectivity is achieved.  

The C# interface for the QA401 (version 1.07) is shown below. 

public interface QA401Interface 
    { 
        /// <summary> 
        /// Returns the friendly name of the host hardware. In the case of the QA401, this will be "QuantAsylum QA401 Audio Analyzer" without  
        /// quotes. This function will succeed whether or not the hardware is attached to the PC, but the QA401 application must be running  
        /// for this to succeed.  
        /// </summary> 
        /// <returns></returns> 
        string GetName(); 
        /// <summary> 
        /// Gets the version number of the software 
        /// </summary> 
        /// <returns></returns> 
        double GetVersion(); 
        /// <summary> 
        /// Returns true if the hardware is connected and functioning.  
        /// </summary> 
        /// <returns></returns> 
        bool IsConnected(); 
        /// <summary> 
        /// Sets the analyzer to a known default state. If fileName is an empty string (which means "", which isn't the same as NULL), then  
        /// the internal default is used. Otherwise, the indicated settings file is loaded. If indicated file name was successfully loaded,  
        /// then true is returned. If the filename is empty then true is always returned and default is always loaded.  
        /// </summary> 
        bool SetToDefault(string fileName); 
        /// <summary> 
        /// This is the same as pressing the RUN button on the front panel when the analyzer is stopped. 
        /// </summary> 
        void Run(); 
        /// <summary> 
        /// This is the same as pressing the RUN button on the front panel when the analyzer is running. 
        /// </summary> 
        void Stop(); 
        /// <summary> 
        /// This will set the Generator 1 to active, to an amplitude of amp1, and a frequency of freq1 and then a measurement will be made  
        /// with the new generator settings. A single acquisition will be performed. After the acquisition finishes, the analyzer will  
        /// automatically stop. The collected data can then be pulled over using the GetData() function. Note that this function only starts  
        /// the acquisition. The function will return immediately, and then the acquistion state must be polled via GetAcquisitionState() to  
        /// know when the acquisition has finished. 
        /// </summary> 
        /// <param name="amp1"></param> 
        /// <param name="freq1"></param> 
        void RunSingle(double amp1, double freq1); 
        /// <summary> 
        /// Performs a single acquisition with all of the current settings. After the acquisition finishes, the analyzer will  
        /// automatically stop. The collected data can then be pulled over using the GetData() function. Note that this function only starts  
        /// the acquisition. The function will return immediately, and then the acquistion state must be polled via GetAcquisitionState() to  
        /// know when the acquisition has finished. 
        /// </summary> 
        void RunSingle(); 
        /// <summary> 
        /// Performs a singe frequency response sweep. 
        /// </summary> 
        /// <param name="amp"></param> 
        void RunSingleFR(double amp); 
        /// <summary> 
        ///  Returns the state of the analyzer. The state will either be STOPPED or BUSY 
        /// </summary> 
        /// <returns></returns> 
        QA401.AcquisitionState GetAcquisitionState(); 
        /// <summary> 
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        /// Retrieves the last collected data. If this is called while the analyzer is busy, the result is undefined. The returned data 
        /// is a PointF array of spectrum data, and each point contains the data amplitude (expressed linearly, and referenced to full  
        /// scale) and data frequency. Typically, you will want to convert this data into dB. 
        /// </summary> 
        /// <param name="channel"></param> 
        /// <returns></returns> 
        PointF[] GetData(QA401.ChannelType channel); 
        /// <summary> 
        /// Retrieves the last collected time-domain data. If this is called while the analyzer is busy, the result is undefined. The  
        /// returned data is a PointF array of time data, and each point contains the data amplitude (y value, ranging from -1 to 1) and time  
        /// </summary> 
        /// <param name="channel"></param> 
        /// <returns></returns> 
        PointF[] GetTimeData(QA401.ChannelType channel); 
        /// <summary> 
        /// Given a previous data acquisition, this will compute the power of the provided data. Note the provided data is in linear form,  
        /// but the returned result is in dB  
        /// </summary> 
        /// <param name="data">array for data consisting of linear amplitude and frequency data</param> 
        /// <returns>Computed power in dB</returns> 
        double ComputePowerDB(PointF[] data); 
        /// <summary> 
        /// Given a previous data acquisition, this will compute the power of the provided data. Note the provided data is in linear form,  
        /// but the returned result is in dB 
        /// </summary> 
        /// <param name="data">array for data consisting of linear amplitude and frequency data</param> 
        /// <returns>Computed power in dB</returns> 
        double ComputePowerDB(PointF[] data, double startFreq, double endFreq); 
        /// <summary> 
        /// Finds the peak and computes the power in presently selected units. Note the data is presented in linear form, but the result  
        /// is returned in dB 
        /// </summary> 
        /// <param name="data"></param> 
        /// <returns></returns> 
        double ComputePeakPowerDB(PointF[] data); 
        /// <summary> 
        /// Given a previous data acquisition, this will compute the THD of the provided data. The fundamental parameter specifies the target 
        /// fundamental, and the max frequency specifies the upper harmonic (in Hertz) that will be considered.  
        /// </summary> 
        /// <param name="data">array for data consisting of linear amplitude and frequency data</param> 
        /// <param name="fundamental">The desired fundamental frequency. The level at this frequency will be suppressed in the calculation,  
        /// while harmonics of this frequency will be used to determine the THD</param> 
        /// <param name="maxFreq">Determines the max frequency that will be used for the THD computation</param> 
        /// <returns>THD level in %</returns> 
        double ComputeTHDPct(PointF[] data, double fundamental, double maxFreq); 
        /// <summary> 
        /// Computes the phase between a reference signal and a second signal and returns the phase between those signals in degrees 
        /// (-180 to +180). The input signals must be sine waves of the exact same frequency. The expected use of this function is as  
        /// follows: In situations where you are measuring a DUT using a single sine generated from the GEN1, the output and input time 
        /// data series can be retrieved using the GetData() call. Once you have the output and input time data, calling this function  
        /// will compute the phase between these signals. If 'applyCompensation' is true, then the routine will account for internal  
        /// delays in the QA401. This will ensure that in loopback mode the phase will be reported as 0 degrees for any frequency  
        /// between 0 Hz and Nyquist. 
        /// </summary> 
        /// <param name="reference">The reference waveform</param> 
        /// <param name="signal">The second signal. If this signal occurs slightly after the reference, this the phase will be indicated 
        /// as lagging</param> 
        /// <param name="applyCompensation">If true, then the routine will compensate for delays inside the QA401. If false, the phase  
        /// calculation will not. The frequency of compensation must be specified if true, otherwise 0 may be used.</param> 
        /// <returns></returns> 
        double ComputePhase(PointF[] reference, PointF[] signal, bool applyCompensation, double compensationFreq); 
        /// Given a previous data acquisition, this will compute the THDN of the provided data. The fundamental parameter specifies the 
        /// target fundamental, and the max frequency specifies the upper harmonic (in Hertz) that will be considered. As this also contains  
        /// a noise calculation, the lower frequency bound must also be specified. It is expected that the minFreq less than fundamental 
which is 
        /// less than maxFreq 
        /// </summary> 
        /// <param name="data">array for data consisting of linear amplitude and frequency data</param> 
        /// <param name="fundamental">The desired fundamental frequency. The level at this frequency will be suppressed in the calculation,  
        /// while harmonics of this frequency will be used to determine the THD</param> 
        /// <param name="maxFreq">Determines the max frequency that will be used for the noise and THD computation</param> 
        /// <param name="minFreq">Determines the min freuqency for the noise calculation</param> 
        /// <returns>THD level in %</returns> 
        double ComputeTHDNPct(PointF[] data, double fundamental, double minFreq, double maxFreq); 
        /// <summary> 
        /// Sets teh generator to the specified amplitude and frequency. The current units are used.  
        /// </summary> 
        /// <param name="gen">Generator 1 or 2</param> 
        /// <param name="isOn">Sets on/off state</param> 
        /// <param name="amp">Sets amplitude</param> 
        /// <param name="freq">Sets frequency. This might be rounded, depending on the host settings</param> 
        void SetGenerator(QA401.GenType gen, bool isOn, double amp, double freq); 
        /// <summary> 
        /// Sets the input and output offsets used in all calculations. 
        /// </summary> 
        /// <param name="inputOffsets"></param> 
        /// <param name="outputOffsets"></param> 
        void SetOffsets(double inputOffsets, double outputOffsets); 
        /// <summary> 
        /// Sets the units for data 
        /// </summary> 
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        /// <param name="type"></param> 
        void SetUnits(QA401.UnitsType type); 
        /// <summary> 
        /// Sets the length of the in and out sample buffers. The buffer length must be a power of 2 and must be a supported buffer 
        /// length. If not a power of two, it will be rounded up to the next power of 2.  
        /// </summary> 
        /// <param name="samples"></param> 
        void SetBufferLength(uint samples); 
 
 
        void SetMuting(QA401.Muting muteState); 
 
        /// <summary> 
        /// Generates a continuous tone on the QA401 hardware at the currently selected sample rate. The tone is generated 
        /// for 'durationMS' milliseconds, and the call blocks during that time 
        /// </summary> 
        /// <param name="amp"></param> 
        /// <param name="freq"></param> 
        /// <param name="timeMS"></param> 
        void GenerateTone(double ampDBV, double freq, int durationMS); 
    } 
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Appendix 4: Regulatory Notice 

Overview & Safety 
This device is test equipment, designed to be used in a laboratory setting. It is used to examine the 

signal characteristics of non-lethal voltages in other equipment, powered from low-energy circuits.  

It is the responsibility of the user to understand what they are measuring, how it might interact with the 

test equipment and what voltages might be generated by their measurements. 

Environmental 

This device is manufactured using RoHS certified parts from leading vendors, assembled in the USA using 

RoHS certified assembly procedures. The case is powder-coated aluminum, the front panel is anodized 

aluminum. This device should be disposed of as you would dispose a personal computer or any other 

electronic device in your community. 

Power Supply 

This device does not operate from line or mains voltage. It is designed to be powered from a low-power 

USB connection. Maximum internally generated voltages do not exceed 12V in magnitude 

Shock Hazard 

This device does not pose a shock hazard when used as recommended. This device is not intended to be 

used for measuring devices that pose a shock hazards. If you measure something that does pose a shock 

hazard, assume the QA401 will provide little assistance in isolating you from that shock hazard.  

FCC 

Test and measurement equipment is exempt from FCC compliance standards because it is used to work 

on open and unshielded equipment which, by definition, is likely unshielded and not operating as 

designed with respect to EMI. The FCC exemption is explained in CFR 47, part 15.103(c): 

(c) A digital device used exclusively as industrial, commercial, or medical test equipment.  
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Appendix 5: Specifications 
See the QA401 Product Brief located on the QA401 product page on the QuantAsylum web site for the 

product specifications.
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